
Windows Registry Tips and Tweaks 
 
1. Default Mail Client ............................................................................................................. 5 
2. Generate Program Fault Log............................................................................................... 5 
3. Remove "Click here to begin"............................................................................................. 5 
4. Disable Windows Animation .............................................................................................. 5 
5. Full-Color Icons .................................................................................................................. 5 
6. Preview BMP images in Windows Explorer ...................................................................... 5 
7. Windows Refresh Rate........................................................................................................ 5 
8. Remove Hidden Shares ....................................................................................................... 5 
9. Outlook 2000/XP Restricted Filetypes................................................................................ 6 
10. Display the Number of Network Errors for a Network Connection ................................... 6 
11. Changes to the Windows Security Screen Title Bar ........................................................... 6 
12. Thumbnail Size ................................................................................................................... 6 
13. Thumbnail Quality .............................................................................................................. 6 
14. Default Email Client ........................................................................................................... 7 
15. Restrict Users from Changing their Home Page ................................................................. 7 
16. Delete Roaming Profiles when logging out ........................................................................ 7 
17. Delete NetMeeting Most Recently Used List ..................................................................... 7 
18. Require a Password in Order to Access a Workstation....................................................... 7 
19. Restrict Users from Changing Their Passwords ................................................................. 7 
20. Remove Shortcut Arrow ..................................................................................................... 8 
21. View/Change System Variables.......................................................................................... 8 
22. Force IE to Open with Full Screen...................................................................................... 8 
23. Change the Name of the Recycle Bin ................................................................................. 8 
24. Restrict Users from Changing File Types........................................................................... 8 
25. Regedit.exe Favourites ........................................................................................................ 8 
26. Edit Windows 2000 “Open With…” List ........................................................................... 9 
27. Restrict Windows Setup Option from Add/Remove Programs Applet .............................. 9 
28. Disable Personalized Menus ............................................................................................... 9 
29. Working with Shares........................................................................................................... 9 
30. How Many Processors Does Your O/S Support ................................................................. 9 
31. Restrict Users from Accessing Windows Update ............................................................... 9 
32. Clear the Windows Run Most Recently Used List ........................................................... 10 
33. Change Main Network Provider (Novell or NT) .............................................................. 10 
34. Remove Shutdown from the Start Menu........................................................................... 10 
35. Password Reminder........................................................................................................... 10 
36. Export Dial-Up Networking Settings................................................................................ 10 
37. Force Windows to Crash................................................................................................... 10 
38. Hide the File Menu in Windows Explorer ........................................................................ 11 
39. Critical Update Notification Delay ................................................................................... 11 
40. Disable CD-ROM Autorun ............................................................................................... 11 
41. Delete Content Advisor Password .................................................................................... 11 
42. Reset Internet Explorer Windows Size ............................................................................. 11 
43. Modify Right-Click Windows Explorer Context Menus .................................................. 11 
44. Browse Remote Computers Faster.................................................................................... 12 



45. Add a Right-Click Context Menu Item to an Unknown File Type................................... 12 
46. Change the name of My Computer ................................................................................... 12 
47. Clear the Outlook 2000 Most Recently Entered Locations for Meetings ......................... 12 
48. Change Windows Explorer Pop-up Tips........................................................................... 13 
49. Activate the NumLock key when Windows Starts ........................................................... 13 
50. Power Down the Computer after Shutdown ..................................................................... 13 
51. Display the Windows version on the Desktop .................................................................. 13 
52. Change Location of Windows Setup Files........................................................................ 13 
53. Internet Explorer Context Menu Items ............................................................................. 13 
54. Internet Explorer Tools Menu Items ................................................................................. 13 
55. Restrict Users from Using GIFs and JPGs as Desktop Wallpaper.................................... 14 
56. Restrict Users from Changing Desktop Wallpaper ........................................................... 14 
57. Clear Internet Explorer Address Bar Auto-complete Entries ........................................... 14 
58. Restrict Users from Logging Off ...................................................................................... 14 
59. Remove Background Tab from Appearing in the Display Applet.................................... 14 
60. Scroll Start Menu or View Multiple Columns .................................................................. 14 
61. Remove Browser Branding ............................................................................................... 15 
62. Internet Explorer Window Title ........................................................................................ 15 
63. Smooth Scrolling in Microsoft Word................................................................................ 15 
64. Remove Desktop Icons ..................................................................................................... 15 
65. Start Menu Delay .............................................................................................................. 15 
66. Sort the Start menu............................................................................................................ 16 
67. Remove Uninstall Items from the Add/Remove Programs Applet................................... 16 
68. Edit Windows Registration Information ........................................................................... 16 
69. Edit Windows Installed User Information ........................................................................ 16 
70. Change Windows Startup Items........................................................................................ 17 
71. Disable the mapped-drive reconnect warning................................................................... 17 
72. Turn off printer announcement broadcasts ....................................................................... 17 
73. Fix EXE Association Problems......................................................................................... 17 
74. Turn off Passport Reminder .............................................................................................. 18 
75. Stop Windows Messenger from Starting with Microsoft Outlook Express...................... 18 
76. Logging Windows Installer activities in Windows 98...................................................... 18 
77. Run Defrag without Problems........................................................................................... 18 
78. Run Scandisk without Problems ....................................................................................... 19 
79. Account Settings ............................................................................................................... 19 
80. Mail Rules ......................................................................................................................... 19 
81. Set Temporary Internet Files Path..................................................................................... 19 
82. Clear Temporary Internet Files when Exiting Internet Explorer ...................................... 20 
83. Disable Balloon Tips......................................................................................................... 20 
84. Decide whether you want dial-up passwords saved.......................................................... 20 
85. Display Customized Message When Windows Starts ...................................................... 20 
86. Suppress the Windows Tour Prompt................................................................................. 20 
87. Disable The Getting Started Screen .................................................................................. 20 
88. Add TLDs To IE’s Autosearch ......................................................................................... 21 
89. Refresh Windows Explorer Windows Immediately ......................................................... 21 
90. Disable the Personalized Favorites Menu feature in IE 5.0 or later.................................. 21 



91. Disable IEs HTML Source Editor Check.......................................................................... 21 
92. Disabling File Shares On Servers ..................................................................................... 21 
93. Delete Page File When You Shut Down Windows .......................................................... 21 
94. Minimize Outlook to the System Tray.............................................................................. 21 
95. Realigning Dropdown Menus ........................................................................................... 21 
96. Display Start Menu Items in Alphabetical Order.............................................................. 22 
97. Set Windows Explorer Toolbar Wallpaper ....................................................................... 22 
98. Enable Notification for Missed Scheduled Tasks ............................................................. 22 
99. Turn off Low Disk Space Notification.............................................................................. 22 
100. Stop Win2K/XP From Fixing Broken Shortcuts .............................................................. 22 
101. Setting the Cache Write Delay.......................................................................................... 22 
102. Verify CD-ROM/CD-R/CD-RW Drive Types ................................................................. 23 
103. Disable New Features of the Windows XP and Windows 2000 Shell ............................. 23 
104. Change Taskbar Background Flashing Settings ............................................................... 23 
105. Disable Office 2000 Clipboard ......................................................................................... 23 
106. Remove Help Option From Start Menu ............................................................................ 23 
107. Modify the Number of Recent Documents Stored in the Documents Menu .................... 23 
108. Resize Windows Minimize and Maximize Buttons.......................................................... 24 
109. Hide the Documents Menu on the Start Menu.................................................................. 24 
110. Disable Documents Menu on the Start Menu ................................................................... 24 
111. Change Your Default Html Editor .................................................................................... 24 
112. Track WindowsUpdate Processes ..................................................................................... 24 
113. Set The Default Domain In Windows NT......................................................................... 24 
114. Set The Alternate Default Domain In Windows NT......................................................... 24 
115. Do Not Display The Username Of The Last User ............................................................ 25 
116. Disable Dragging To The Start Menu............................................................................... 25 
117. Clear Windows Media Player Most Recently Used (MRU) List...................................... 25 
118. Enable services through the registry ................................................................................. 25 
119. Disable Automatic Update Checking in Windows Media Player ..................................... 25 
120. Internet Explorer DNS Cache Timeout............................................................................. 25 
121. Adding the My Computer Security Zone.......................................................................... 26 
122. Increase Icon Cache Size .................................................................................................. 26 
123. Disable IE’s Clicking Sound When You Click On A Link .............................................. 26 
124. Change Default Wallpaper Folder .................................................................................... 26 
125. Hide Windows 2000/XP Places Bar ................................................................................. 26 
126. Edit Windows 2000/XP Default Places Bar...................................................................... 26 
127. Reinstalling Internet Explorer 6.0 ..................................................................................... 28 
128. Reinstall Outlook Express 6.0........................................................................................... 29 
129. Show Which Domain a PC Is Logging In To ................................................................... 29 
130. Find BIOS Information in the Registry............................................................................. 29 
131. Disable Internet Explorer Advanced Tab.......................................................................... 29 
132. Display the local Administrator account on the Windows XP Welcome screen? ............ 29 
133. Tweak the registry to disable the Shut Down button ........................................................ 29 
134. Disable Notification balloon tips ...................................................................................... 30 
135. Disable 8.3 characters names on NTFS partitions ............................................................ 30 
136. Disable multi-user editing in Microsoft Word 2002 ......................................................... 30 



137. Disable the search assistant in Microsoft Internet Explorer (IE) 6.0 ................................ 30 
138. Disable the Windows Explorer search assistant in Windows XP..................................... 30 
139. Edit registry to read all e-mail as plain text ...................................................................... 30 
140. Overwrite Deleted Information in Microsoft Outlook 2000/2002.................................... 30 
141. Stop unwanted user access by turning off cached logins .................................................. 31 
142. Change location of Print Spooler ...................................................................................... 31 
 
 



1. Default Mail Client 
HKEY_CLASSES_ROOT\mailto\shell\open\command. 
 
Under command, enter the full path to the email client then %1 
c:\internet\Netscape\program\netscape.exe %1 
c:\program files\internet explorer\iexplore.exe %1 

2. Generate Program Fault Log 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\FaultLo
gFile 
 
Value should be the path and filename of the log file 

3. Remove "Click here to begin" 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explo
rer\NoStartBanner 
 
Set this hex value to 01,00,00,00 

4. Disable Windows Animation 
HKEY_CURRENT_USER \Control Panel \Desktop \WindowMetrics\MinAnimate 
 
Set this to 1 

5. Full-Color Icons 
HKEY_CURRENT_USER\Control Panel\desktop\WindowMetrics\Shell Icon BPP 
 
Give it a value of 16 

6. Preview BMP images in Windows Explorer 
HKEY_CLASSES_ROOT\PAINT.PICTURE\DefaultIcon 
 
Set value to "%1" 

7. Windows Refresh Rate 
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\Update\UpdateMode 
 
Setting value to 00 will force an instant update to Windows Explorer. 

8. Remove Hidden Shares 
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\LanmanServer\Parame
ters\AutoShareServer 
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\LanmanServer\Parame
ters\AutoShareWks 



 
Both of these REG_DWORD values set to 0 will prevent hidden shares from working 
(c$, etc.) 

9. Outlook 2000/XP Restricted Filetypes 
HKEY_CURRENT_USER\Software\Microsoft\Office\10.0\Outlook\Security\Level1Re
move 
 
It is possible to add Filetypes back into the OK zone. This will allow you to open these 
attachments from Outlook (they won’t be blocked). 
This key lists all of the file extensions that will be blocked by Outlook. You can edit this 
key to either remove extensions that you want access to or add extensions that you want 
to block. 

10. Display the Number of Network Errors for a Network Connection 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Network\Connection
s\StatMon\ShowLanErrors 
(Windows 2000) 
 
You can display a LAN connection-error count on the General tab of the connection's 
Status dialog box in Win2K This REG_DWORD when set to 1 will display the errors 
that have occurred over a network connection. The default value is 0 will not display the 
errors. Note that the Errors field looks a little odd, because of a bug in how the Status 
dialog box accommodates the error information. 

11. Changes to the Windows Security Screen Title Bar 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\Winlogon\ Welcome 
(Windows NT/2000) 
 
This REG_SZ data type will display a custom string on the title bar of the Windows 
Security Screen that you see when you invoke the Ctrl+Alt+Del keystroke. 

12. Thumbnail Size 
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Explorer\Th
umbnailSize 
 
This DWORD value can be set between 32 and 256. This number represents the size in 
pixels that the Windows Explorer Thumbnail view will display. 

13. Thumbnail Quality 
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Explorer\Th
umbnailQuality 
 
This DWORD value will determine the quality of the thumbnail image quality. This 
number can be set between 50 and 100 



14. Default Email Client 
HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail 
 
From the Internet Options applet of the Control Panel, click on the Programs tab. The 
program that Internet Explorer will try to open when you click on an email link is here 
(my default is Outlook, although I could also choose Hotmail or Outlook Express). This 
registry key is where this information is saved. If your favourite email program won’t set 
itself up here, then you can go to this registry key, and following the example of the ones 
already setup, try and set your program up. 

15. Restrict Users from Changing their Home Page 
HKEY_CURRENT_USER\Software\Policies\Microsoft\Internet Explorer\Control 
Panel\HomePage 
 
This DWORD set to 1 will make it so users cannot change their Internet Explorer home 
page. Setting it to 0 will allow the home page to be changed. 

16. Delete Roaming Profiles when logging out 
HKEY_LOCAL_MACHINE\Software\Microsoft\WindowsNT\CurrentVersion\Winlogo
n\DeleteRoamingCache 
 
This value set to 1 will cause Windows to delete Roaming Profiles (if they are enabled on 
a network). This value set to 0 will keep the profile. 

17. Delete NetMeeting Most Recently Used List 
HKEY_USERS\[LongNumber/String]\Software\Microsoft\Conferencing\UI\CallMRU 
 
Each of the Addr# values can be deleted or changed. This will delete IP addresses that are 
showing up in the Netmeeting recently used list. 

18. Require a Password in Order to Access a Workstation 
HKEY_LOCAL_MACHINE\Network\Logon\MustBeValidated 
 
This REG_DWORD set to 1 forces a user to enter a password to login to the local 
workstation. Setting it to 0 allows them to press Esc and bypass a password. 

19. Restrict Users from Changing Their Passwords 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Syste
m\DisableChangePassword 
(Windows 2000) 
 
Setting this REG_DWORD to 1 will stop users from being able to change their 
passwords. 



20. Remove Shortcut Arrow 
HKEY_CLASSES_ROOT\lnkfile\IsShortcut 
HKEY_CLASSES_ROOT\piffile\IsShortcut 
 
Delete these values if you want to remove the arrow that appears on all shortcuts. 

21. View/Change System Variables 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SessionManager\Env
ironment 
(Windows 2000) 
 
All of the values in this key are system variables that can be used by programs. You can 
make changes to the variables. 

22. Force IE to Open with Full Screen 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\Main\fullscreen 
 
This STRING value set to "yes" will force new IE Windows to full screen. Note: This 
does not work for me on my Windows 2000/IE 6 system. 

23. Change the Name of the Recycle Bin 
HKEY_CLASSES_ROOT\CLSID\{645FF040-5081-101B-9F08-
00AA002F954E}\LocalizedString 
 
Changing the text at the end of this value from Recycle Bin to the text of your choice will 
change the name of the recycle bin. 

24. Restrict Users from Changing File Types 
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Policies\Exp
lorer\NoFileAssociate 
 
This REG_DWORD value set to 1 will prevent users from changing file type 
associations. Setting it to 0 will allow them to make changes. 

25. Regedit.exe Favourites 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Applets\Reged
it\Favorites 
(Windows 2000) 
 
The Windows 2000 Registry Editor (Regedit.exe) provides you with the ability to add 
frequently visited registry keys to a Favourites menu. This enables you to open those 
registry keys quickly without having to browse through the Registry Editor for them. This 
registry key is where the Favourites are stored. 

 
 



26. Edit Windows 2000 “Open With…” List 
KEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\FileExt
s\.extension\OpenWithList (where extension equals the file extension that you want to 
open) 
(Windows 2000) 
 
This string (REG_SZ_ values) identifies a program that will open files of this type. You 
can remove values if you don’t want those programs to open that file type, or you can add 
items to add new programs. 

27. Restrict Windows Setup Option from Add/Remove Programs Applet 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Unins
tall\NoWindowsSetupPage 
(Windows 2000) 
 
Settings this REG_DWORD to 1 will prevent users from seeing the Add/Remove 
Windows Components Button in the Add/Remove Programs applet of the Control Panel. 

28. Disable Personalized Menus 
HKEY_CURRENT_USER\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\E
xplorer\NoInstrumentation 
(Windows 2000) 
 
This REG_DWORD set to 1will disable personalized menus. 

29. Working with Shares 
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\LanmanServer\Shares 
 
All of the shares on your computer are listed here. To remove a share, delete the key. 
It is also a good way to migrate shares to a new server. If you rebuild a server, you can 
export this key and associated sub-keys from your old server and import them on your 
new server and all of the shares will be set up for you. 

30. How Many Processors Does Your O/S Support 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session 
Manager\RegisteredProcessors 
(Windows 2000) 
 
Check the registry value to see how many processors your version of Windows supports. 
This registry key value is informational only. In other words, changing the value to 128 
won’t enable your version of Windows to support 128 processors. 

31. Restrict Users from Accessing Windows Update 
HKEY_CURRENT_USER\Software\Microsoft\Windows\ 
CurrentVersion\Policies\Explorer\NoWindowsUpdate 



 
To disable Windows Update on a per user basis set (or create) this DWORD value to 1. If 
you want to enable WindowsUpdate, delete this value, or change it to 0. 

32. Clear the Windows Run Most Recently Used List 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Run
MRU 
 
Deleting the values in this key will clear the log list of commands that is created when 
you use Run on Windows’ Start menu. 

33. Change Main Network Provider (Novell or NT) 
HKEY_LOCAL_MACHINE\Microsoft\Windows NT\CurrentVersion\Winlogon 
(Windows 2000 Professional) 
 
The GINADLL value is set for either a Microsoft logon screen or a Novell login screen. 
If you want to use a Novell login screen, make sure that the value is NWGINA.DLL. If 
you want to use a Microsoft Login screen, make sure the value is MSGINA.DLL. Then 
close the Registry Editor and restart the system. 

34. Remove Shutdown from the Start Menu 
HKEY_CURRENT_USER\Software\Microsoft\Windows\Current 
Version\Policies\Explorer\NoClose 
 
This String Value set to 1 removes the Shutdown option from the Startmenu. Change it to 
0 to allow shutdowns. 

35. Password Reminder 
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows 
NT\CurrentVersion\Winlogon\PasswordExpiryWarning 
(Windows 2000) 
 
This key in Windows 2000 sets the number of days before a user’s password must be 
changed. 

36. Export Dial-Up Networking Settings 
HKEY_CURRENT_USER\RemoteAccess\Addresses 
 
This key is where the Dial-Up Networking settings are stored. 

37. Force Windows to Crash 
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\i8042prt\Parameters\Cr
ashOnCtrlScroll 
(Windows NT/2000) 
 



Set this DWORD value to 1. After a reboot, hold down the right CTRL key and hit the 
Scroll Lock key twice. This generates a BSOD. This is intentional as it can be used for 
testing purposes. 

38. Hide the File Menu in Windows Explorer 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explo
rer 
 
Change (or create) the NoFileMenu value to 1 to hide the File menu, or 0 to show it. 

39. Critical Update Notification Delay 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\WindowsUpdate\Critical 
Update\CurrentDelayInterval 
 
This REG_DWORD value is the value in seconds between prompts from the Critical 
Update Notification. The default is 86,400 seconds (1 day). 

40. Disable CD-ROM Autorun 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Cdrom 
 
Changing this value to 1 disables the CD-ROM autorun feature. 

41. Delete Content Advisor Password 
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Policies\Rati
ngs 
 
If you are using the Content Advisor in Internet Explorer and have forgotten the 
password, you can delete this key and reset all of the ratings and delete the password. 

42. Reset Internet Explorer Windows Size 
HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\Main\Window 
placement 
 
Deleting this value will reset the size of the IE Window. 

43. Modify Right-Click Windows Explorer Context Menus 
HKEY_CLASSES_ROOT\*\shellex\ContextMenuHandlers 
HKEY_CLASSES_ROOT\Directory\shellex\ContextMenuHandlers 
HKEY_CLASSES_ROOT\Folder\shellex\ContextMenuHandlers 
HKEY_CLASSES_ROOT\Drive\shellex\ContextMenuHandlers 
 
These 4 keys are where the Right-Click menu options are stored for folders, directories, 
and drives. To remove a right-click context menu item, you could delete any of the sub-
keys that are below these keys. 



44. Browse Remote Computers Faster 
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\Current 
Version\Explorer\RemoteComputer\NameSpace\{D6277990-4C6A-11CF-8D87-
00AA0060F5BF} 
(Win2000) 
 
This key instructs Windows Explorer to search for Scheduled Tasks when you are trying 
to connect to a remote computer. To browse Windows 2000 and 98 computers faster, 
delete the key. 

45. Add a Right-Click Context Menu Item to an Unknown File Type 
HKEY_CLASSES_ROOT\Unknown\Shell  
 
To add a right-click context menu item to an unknown file type, right-click on the Shell 
subkey and choose New - Key. This will add a new subkey below the Shell. Give the new 
subkey the name of the application, as you’d like it displayed on the context menu.  
Next, you’ll need to create another new subkey under your newly created application 
subkey called command. There will be a Default value automatically created. Double 
click this value and enter the full path of the application’s executable file, but append a 
%1 to the end (i.e. c:\winnt\notepad.exe %1). 
The next time you right-click on that unknown file extension, you should see your new 
menu item. 

46. Change the name of My Computer 
HKEY_CLASSES_ROOT\CLSID\{20D04FE0-3AEA-1069-A2D8-
08002B30309D\LocalizedString 
(Win2000)  
 
From this value you can change the name of the My Computer icon. The default value is: 
@D:\WINNT\system32\shell32.dll,-9216@1033,My Computer 
As you can see, the name is the last part after the , and you can change this to whatever 
you want. A neat trick is to change the My Computer part to %computername% and that 
will name My Computer the name that your computer has in the Network settings. If you 
do this it should look like this: 
@C:\WINNT\system32\shell32.dll,-9216@1033,%computername% 

47. Clear the Outlook 2000 Most Recently Entered Locations for Meetings 
HKEY_CURRENT_USER\Software\Microsoft\Office\9.0\Outlook\Preferences\Location
MRU 
 
This key contains the most recent entered locations for meetings and appointments in 
Outlook 2000. You can’t edit any of these, but you can delete then entire value. 



48. Change Windows Explorer Pop-up Tips 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explore
r\Tips 
 
There are 50 tips stored in this key. You can double-click on any of them to edit the tips. 

49. Activate the NumLock key when Windows Starts 
HKEY_USERS\.DEFAULT\Control Panel\Keyboard\InitialKeyboardIndicators 
(WinNT/2000) 
 
This REG_SZ or String value when set to 2 will make the NUMLOCK turn on when 
Windows loads. A value of 0 will turn the numlock off. 
This will make the change for all users. If you want to do it for an individual user, then 
change the same value in the HKEY_CURRENT_USER hive. 

50. Power Down the Computer after Shutdown 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\Winlogon\PowerdownAfterShutdown 
(WinNT/2000) 
 
This REG_SZ or String value when set to 1 will automatically power off your computer 
if the BIOS supports this. A value of 0 will leave you at the "It is now safe..." screen. 

51. Display the Windows version on the Desktop 
HKEY_CURRENT_USER\ControlPanel\Desktop\PaintDesktopVersion 
 
In Windows 2000, a DWORD value of 1 will display the Windows version on the 
desktop. A value of 0 does not display it. 

52. Change Location of Windows Setup Files 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\ 
Setup\SourcePath 
 
This REG_SZ or String Value key stores the path to the location of the installation files. 

53. Internet Explorer Context Menu Items 
HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\MenuExt  
 
These are menu items that appear in the Right-Click menu of Internet Explorer 

54. Internet Explorer Tools Menu Items 
HKEY_LOCAL_MACHINE\Software\Microsoft\Internet Explorer\Extensions 
HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\Extensions 
 
Each subkey of these keys define an addition to IE’s Tools menu 



55. Restrict Users from Using GIFs and JPGs as Desktop Wallpaper 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Activ
eDesktop\NoHTMLWallPaper 
 
To restrict users from using GIFs and JPGs as wallpaper (restrict them to BMP images) 
create or set this value to 1. A value of 0 will allow users to use all 3 types of images. 

56. Restrict Users from Changing Desktop Wallpaper 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Activ
eDesktop\NoChangingWallpaper 
 
This DWORD value 1 will stop people from being able to change their desktop 
wallpaper. A value of 0 will allow users to change the wallpaper. 

57. Clear Internet Explorer Address Bar Auto-complete Entries 
HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\TypedURLs 
(Win9x) 
HKEY_USERS\S-1-5-21...\Software\Microsoft\Internet Explorer\TypedURLs 
(WinNT/2000) 
 
When you type a URL in Internet Explorer (IE), the system automatically completes 
known entries with data stored in this registry key. Each time you type in a URL and 
press the Enter key or the Go button, that URL is stored in this location. 

58. Restrict Users from Logging Off 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explo
rer\NoLogOff  
 
This DWORD value set to 1 will remove the "Log Off User" option in the Start Menu. A 
value of 0 will show it. 

59. Remove Background Tab from Appearing in the Display Applet 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Syste
m\NoDispBackgroundPage  
 
This DWord value set to 1 will stop the Background page of the Display applet from 
appearing. Setting it to 0 will cause it to appear. 

60. Scroll Start Menu or View Multiple Columns 
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Explorer\Ad
vanced\StartMenuScollPrograms 
 
This String entry in the registry can be created if it doesn’t exist. If you set it to FALSE it 
will make the start menu run into multiple columns. This works with IE5. You have 
probably noticed that if your Start Menu is too long, you get a little arrow at the top or 



bottom of the Programs menu telling you that you need to scroll to see what else is there. 
You can change this to behave the way Windows 95 used to. 

61. Remove Browser Branding 
HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\Toolbar\BrandBitmap 
HKEY_CURRENT_USER\Software\Microsoft\Internet 
Explorer\Toolbar\SmBrandBitmap 
 
If you downloaded IE from ZDNet, Tucows, or any other major site, it is probably 
"branded", meaning that it probably has its own logo in the upper-right corner and in the 
title bar it says the branded name. These 2 registry settings should be deleted if you want 
to remove the branded logo. This will set it back to the default IE globe. 
http://support.microsoft.com/support/kb/articles/Q176/7/13.ASP 

62. Internet Explorer Window Title 
HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\Main\Window Title 
 
This is where you can change the browser name that appears in the Internet Explorer 
window title. You can change it to anything you want. 

63. Smooth Scrolling in Microsoft Word 
HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Word\Options\LiveScrolling 
 
This features allows you to have smooth scrolling in Word 97. When you use the scroll 
bars in Word 97, you can’t see the document as it scrolls by until you let go of the scroll 
bar. Adding this LiveScrolling setting and setting it to 1 will allow you to see document 
scroll by. 

64. Remove Desktop Icons 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Eexplor
er\Desktop\NameSpace 
 
A lot of programs install themselves and add an icon to the desktop. The problem is, this 
isn’t just a shortcut that can be deleted. These are permanent links to certain 
programs/features. In order to delete them, you need to navigate to this registry key and 
delete any entries you do not want. 

65. Start Menu Delay 
HKEY_CURRENT_USER\Control Panel\Desktop\MenuShowDelay 
 
This registry entry will control how fast each menu sub-level appears and how fast the 
taskbar will appear if you have autohide set up. The number that you enter will be the 
time in milliseconds the operating system will pause. 1 second would need an entry of 
1000. I usually set mine at 0 so that it appears as quick as it can. 



66. Sort the Start menu 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Men
uOrder 
 
This registry key is where you would go in Windows 98 and Windows 95 with the 
windows update installed to fix your menu order. Maybe you haven’t noticed, but the 
menu items in the Start Menu and in the Favorites folder don’t have to be in alphabetical 
order. By dragging them, you can put them in any order you want. The problem is, once 
you have changed one, you can never get it back to alphabetical order without fixing it in 
the registry. 
From the MenuOrder key, choose which sub key you want to edit, the Start Menu or the 
Favorites. You will see more sub keys that are called Menu. You can either delete that 
key, or delete the binary Order listing in the right hand pane. You can search through all 
of the sub keys for the same thing and reset any of them that you want. 
If you don’t like working in the registry, there is a PC Magazine utility available called 
MenuZap that you can download which does all of this automatically for you. Visit 
http://www.zdnet.com/pcmag/ and do a search for MenuZap to find it. 

67. Remove Uninstall Items from the Add/Remove Programs Applet 
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Uninstall 
 
This registry key contains all of the sub keys for programs that can be uninstalled. When 
you want to uninstall, always use the uninstall program that came with the program or use 
the Add/Remove Programs applet of the Control Panel. This registry key can be useful 
when you have done that, but the program still comes up in the Add/Remove Programs 
listing. When you click on it it says "Can’t find this file." Well, of course it can’t, it has 
been uninstalled. It is just that the registry listing hasn’t been removed. 
To remove it, just visit this key, and then scroll down until you see the culprit. You might 
have to click on the sub key once so that the real name shows up in the right hand pane. 
Sometimes the sub key names don’t make a lot of sense. 

68. Edit Windows Registration Information 
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion 
 
This registry key will allow you to change to information you inputted about who 
Windows was registered to. You can change the company, persons name, the registration 
key, etc. 

69. Edit Windows Installed User Information 
HKEY_CURRENT_USER\Software\Microsoft\MS Setup (ACME)\User Info 
 
Have you noticed that when you install programs, it quite often automatically knows your 
name and your company name? That information does not come from the registry key 
mentioned above this one. It is found in this one. If you have gotten a used computer 



from someone or have changed companies and want to change those names, then visit 
this key. 

70. Change Windows Startup Items 
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Run 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Run 
 
This registry key will help you when there are programs starting up that you don’t want 
running. When you install something like Norton Utilities or an antiviral program, they 
load up at start up and put a small icon in the system tray. You probably want most of 
these programs running, but lets say that you don’t want it running. How do you get rid of 
it. There should be an option in the program setup, but if you just can’t find it, you can go 
to this key, or any other that starts with RUN and delete the listing in the right hand pane. 
For instance, Power Management is installed by default by Windows, even if you go into 
the power settings and tell it you want the computer on all the time, there is still a line in 
the RunServices key. It wasn’t doing any harm because the power profile was set so that 
everything was on all the time, but why even have the profile in there is I don’t use it. So 
I deleted it. 

71. Disable the mapped-drive reconnect warning 
HKEY_CURRENT_USER\Network\RestoreDiskChecked 
 
If you have mapped a network share to a drive letter, you can automatically remap it each 
time your computer starts. If the network share isn’t available anymore, then you a 
window pops up telling you this and asks you if you’d like to remap the drive again next 
time. This can get annoying. This DWORD set to 0 will disable the warning. Changing it 
to 1 will re-enable the warning. 

72. Turn off printer announcement broadcasts 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Print\ 
DisableServerThread 
 
This DWORD value set to 1 will prevent your computer from sending out 
announcements that it has printers shared. Setting it back to 0 renews the broadcasts. 
This will prevent printers from appearing when browsing the network, but the printers are 
still available as long as their share name is known. 

73. Fix EXE Association Problems 
HKEY_LOCAL_MACHINE \ Software \ Classes \ Exefile \ Shell \ Open \ Command 
 
Do you ever get the error “Windows cannot find PROGRAM.EXE. This program is 
needed for opening files of type 'Application’”? 
If so, then go to this registry key and make sure that it has the value: 
"%1" %* (exactly as shown). 



74. Turn off Passport Reminder 
(Windows XP) 
HKEY_CURRENT_USER\Software\Microsoft\MessengerService\PassportBalloon 
 
When this value is set to 0a, you won’t have the Passport reminder popup anymore. 

75. Stop Windows Messenger from Starting with Microsoft Outlook 
Express 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Outlook Express\ Hide Messenger  
 
This DWORD value set to 2 will stop Windows Messenger from starting with Microsoft 
Outlook express. 

76. Logging Windows Installer activities in Windows 98  
HKEY_LOCAL_MACHINE\Software\Policies\Microsoft\Windows\Installer\Logging 
 
Windows Installer can log its activity. Give this String value a value of voicewarmup and 
you’ll get full logging. 
 
The value may appear a little unusual, but each letter turns on a separate logging feature 
(the letters can be entered in any order): 

i - Status messages 
w - Non-fatal warnings 
e - All error messages 
a - Start up of actions 
r - Action-specific records 
u - User requests 
c - Initial UI parameters 
m - Out-of-memory or fatal exit information 
o - Out-of-disk-space messages 
p - Terminal properties 
v - Verbose output 
+ - Append to existing file 
! - Flush each line to the log 
"*" - Wildcard, log all information 
 except for the v option. 
To include the v option, specify "/l*v". 

77. Run Defrag without Problems 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Applets\Defra
g\Settings\Disable loadqm.exe 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Applets\Defra
g\Settings\ Disable loadwc.exe 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Applets\Defra
g\Settings\ Disable ScreenSaver 



HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Applets\Defra
g\Settings\ Disable Wkdetect.exe 
(Windows 9x/ME) 
 
Set each of these values to YES to disable these programs while Defrag is running 
LOADWC.EXE (Windows Update Checker), LOADQM.EXE (Query Manager), and 
WKDETECT.EXE (Update Checker for Microsoft Works). 

78. Run Scandisk without Problems 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Applets\Scand
isk\Settings\ Disable loadqm.exe 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Applets\Scand
isk\Settings\ Disable loadwc.exe 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Applets\Scand
isk\Settings\ Disable ScreenSaver 
(Windows 9x/ME) 
 
Set each of these values to YES to disable these programs while Defrag is running 
LOADWC.EXE (Windows Update Checker), LOADQM.EXE (Query Manager), and 
WKDETECT.EXE (Update Checker for Microsoft Works). 

79. Account Settings 
HKEY_CURRENT_USER\Software\Microsoft\Internet Account Manager 
 
Your Outlook Express Email Account settings are stored in this registry setting. 

80. Mail Rules 
HKEY_CURRENT_USER\Identities  
 
You’ll find all the information about mail rules and other per-identity settings here, stored 
in sub-keys identified by your unique ID string. It will look something like this: 
{36553740-2BAC-11D3-95B1-00A0C993DADF} 
If you are importing information for the same user that you had when you exported this 
key, all will be fine. If you have recreated this user, or created a new one, the unique ID 
will be different, and so you will a bit of work to make it work. 

81. Set Temporary Internet Files Path 
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Internet 
Settings/Cache/Paths/Path1-4 
 
This registry setting will show you where your Temporary Internet Files are stored. 
You can delete the sub-paths, but not the main Paths key. You can also change the 
location of these paths. 
If you delete the Paths1-4, and set the value of Directory to a location, then you will have 
only 1 path (and no sub-paths). 



82. Clear Temporary Internet Files when Exiting Internet Explorer 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Internet 
Settings\Cache\Persistent 
 
This REG_DWORD key when set to 0x00000000 (0) will clear your Temporary Internet 
Files folder when you exit Internet Explorer. This value set to 0x00000001 (1) will not 
clear it.  

83. Disable Balloon Tips 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Adva
nced\ EnableBalloonTips 
(Windows XP) 
 
This DWORD value set to 0 will disable the balloon tips. The value of 1 will enable the 
tips. 

84. Decide whether you want dial-up passwords saved  
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services \RasMan\Parameters  
Add a value named DisableSavePassword  
 
This REG_DWORD set it to 1 will stop Dial-Up Networking from saving the password. 
A setting of 0 will save the password. 

85. Display Customized Message When Windows Starts 
HKEY_LOCAL_MACHINE\Software\MicrosoftWindows\CurrentVersion\Winlogon\ 
LegalNoticeCaption 
HKEY_LOCAL_MACHINE\Software\MicrosoftWindows\CurrentVersion\Winlogon\ 
LegalNoticeText 
 
These strings will display a small window when a computer first starts up. The caption is 
the name of the window. The text is the message itself in the window. 

86. Suppress the Windows Tour Prompt 
(Windows XP) 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Applets\
Tour\ RunCount 
 
This DWORD value set to 0 will stop the Windows Tour from appearing 

87. Disable The Getting Started Screen 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\
Explorer\NoWelcomeScreen 
 
This REG_DWORD value set to 1 disables the Getting Started screen. 0 enables it.  



88. Add TLDs To IE’s Autosearch 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet 
Explorer\Main\UrlTemplate 
 
For Value Name, enter the next number available. This REG_SZ value will be setup the 
same way the existing ones are (www.%s.TLD, with TLD being .com, .edu, .biz, etc.) 

89. Refresh Windows Explorer Windows Immediately 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Update\UpdateMode 
 
This DWORD value set to 00 will force Windows to refreshe windows quicker 

90. Disable the Personalized Favorites Menu feature in IE 5.0 or later 
HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\Main\FavIntelliMenus 
 
Set this value to “no” (without the quotes). 

91. Disable IEs HTML Source Editor Check 
HKEY_CURRENT_USER\Software\Microsoft\Internet 
Explorer\Main\CheckDocumentForProgID 
 
This String value set to “no (without the quotes) will stop Internet Explorer from 
changing the program that you can use to edit a current web page. 

92. Disabling File Shares On Servers 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\lanmanserver\Param
eters\ AutoShareServer 
 
This REG_DWORD value set to 0 will remove the default file shares 

93. Delete Page File When You Shut Down Windows  
HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\CONTROL\SESSI
ONMANAGER\MEMORYMANAGEMENT\ClearPageFileAtShutdown 
 
This value set to 1 will clear the paging file when a computer is shut down 

94. Minimize Outlook to the System Tray 
HKEY_CURRENT_USER\Software\Microsoft\Office\10.0\Outlook\Preferences\MinTo
Tray 
 
This REG_DWORD value set to 1 will minimize Outlook 2002/XP to the system tray 
rather than to the task bar. 

95. Realigning Dropdown Menus 
HKEY_CURRENT_USER\Control Panel\Desktop\MenuDropAlignment 



 
This String value set to 1 will cause menus to drop down from the right rather than the 
left. 

96. Display Start Menu Items in Alphabetical Order 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer 
MenuOrder 
 
Delete this key and the menu will be reset to be in alphabetical order. 

97. Set Windows Explorer Toolbar Wallpaper 
HKEY_CURRENT_USER\Software\Microsoft\Internet 
Explorer\Toolbar\BackBitmapShell 
 
This String value contains the location of the bitmap (BMP) image that you would like to 
use as the toolbar wallpaper. 

98. Enable Notification for Missed Scheduled Tasks 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\SchedulingAgent\NotifyOnTaskM
iss 
 
This DWORD value set to 1 will enable missed tasks notification. Setting this value to 0 
will disable notification. 

99. Turn off Low Disk Space Notification 
(Windows XP) 
HKEY_Current_User\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer\ 
NoLowDiskSpaceChecks 
 
This DWORD value set to 1 will disable the low disk space notification. 0 will enable it. 

100. Stop Win2K/XP From Fixing Broken Shortcuts 
HKEY_Current_User\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer\ 
NoResolveTrack 
 
This DWORD set to 1 will stop Windows 2000 and XP from trying to automatically fix 
shortcuts. 0 will enable it. 

101. Setting the Cache Write Delay 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\CacheW
riteDelay 
(Windows 2000) 
 
This DWORD value (in milliseconds) controls the time that Windows waits before it tries 
to shut down. This will allow time for the cache to be written permanently to the disk. 



102. Verify CD-ROM/CD-R/CD-RW Drive Types 
(Windows XP) 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\CD 
Burning\Drives 
 
Each CD drive will have its own Volume key. Double-click the "Drive Type" value to 
change its properties. CD-Rs should be set to 1; CD-RWs should be set to 2; non-
writables should be set to 3. 

103. Disable New Features of the Windows XP and Windows 2000 Shell 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explo
rer\ClassicShell 
 
This DWORD value set to 1 will disable many of the newer features of the Windows 
Shell 

104. Change Taskbar Background Flashing Settings 
HKEY_CURRENT_USER\Control Panel\Desktop\ForegroundFlashCount 
 
This REG_DWORD value sets the number of times that a background application flashes 
letting you know that it wants to take control 

105. Disable Office 2000 Clipboard 
HKey_CURRENT_USER\Software\Microsoft\Office\9.0\Common\General\AcbControl 
 
Setting this DWORD value to 1 (Decimal) will stop the Office 2000 clipboard from 
popping up. 

106. Remove Help Option From Start Menu 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explo
rer\ NoSMHelp 
(Windows 2000) 
 
This REG_DWORD set to 1 will remove the Start Menu Help menu. You must log off 
and back on for this change to take effect. Setting this to 0 will show the Help menu. 

107. Modify the Number of Recent Documents Stored in the Documents 
Menu 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\ 
Explorer\MaxRecentDocs 
 
Set this DWORD value to the number of documents that you would like on the 
Documents menu of the Start Menu. The Windows default is 15. The number you choose 
must be in multiples of 15. 



108. Resize Windows Minimize and Maximize Buttons 
HKEY_CURRENT_USER\Control Panel\Desktop\WindowMetrics\CaptionWidth 
HKEY_CURRENT_USER\Control Panel\Desktop\WindowMetrics\CaptionHeight 
 
Change these 2 registry values to change the size of the Minimize and Maximize buttons.  

109. Hide the Documents Menu on the Start Menu 
HKEY_CURRENT_USER\Software\Microsoft\Windows\Current 
Version\Policies\Explorer\NoRecentDocsMenu 
 
Set this DWORD value to 1 to hide the Documents menu. Shortcuts will still be added to 
the Documents, but since you don’t see the menu, you don’t see the shortcuts. 

110. Disable Documents Menu on the Start Menu 
HKEY_CURRENT_USER\Software\Microsoft\Windows\Current 
Version\Policies\Explorer\NoRecentDocsHistory 
 
Set this DWORD value to 1 to stop Windows from even keeping track of document 
history 

111. Change Your Default Html Editor  
HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\Default 
HTML\Editor\Description 
HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\Default 
HTML\Editor\shell\edit\command 
 
In the first registry key, change the description to the name of your HTML Editor. 
In the second key, change the default REG_SZ data to the fully qualified pathname for 
your editor. 

112. Track WindowsUpdate Processes 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Active Setup\SteppingMode 
 
Set this string value to Y in order to track the process. Change it to N to ignore the 
process. 

113. Set The Default Domain In Windows NT 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\Winlogon\DefaultDomainName 
 
This string value should be set to the value to the preferred domain. 

114. Set The Alternate Default Domain In Windows NT 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\Winlogon\AltDefaultDomainName 



 
This string value should be set to the value to the alternative preferred domain. 

115. Do Not Display The Username Of The Last User 
HKEY_LOCAL_MACHINE \Software\Microsoft\Windows\Current 
Version\WinLogon\DontDisplayLastUserName 
 
This Reg_SZ value should be set to 1 to stop the last user name from appearing in the 
Logon window 

116. Disable Dragging To The Start Menu 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explo
rer\NoChangeStartMenu 
 
This REG_DWORD should be set to 1 

117. Clear Windows Media Player Most Recently Used (MRU) List 
HKEY_CURRENT_USER\Software\Microsoft\MediaPlayer\Player\RecentFileList 
 
Delete this key to clear the Windows Media Player most recently played file list. 

118. Enable services through the registry 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services 
 
To enable (or change the startup options for) services on the local computer, locate the 
Service, and set Start value to: 

0 -boot 
1 -system 
2 -automatic 
3 -manual 

119. Disable Automatic Update Checking in Windows Media Player 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Policies\WindowsMediaPlayer\Dis
ableAutoUpdate (WMP 7) 
 
This REG_DWORD value should be set to 1. A value of 0 enables automatic updates. 
 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\MediaPlayer\EnableAutoUpgrade 
(WMP 6.4) 
 
This REG_SZ value should be set to No. A value of Yes enables automatic updates. 

120. Internet Explorer DNS Cache Timeout 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Internet 
Settings\DnsCacheTimeout 



 
 
Since Internet Explorer 4.0, the DNS cache has been resetting itself every thirty minutes. 
Change this DWORD to the number of seconds between Cache purges. 

121. Adding the My Computer Security Zone 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Internet 
Settings\Zones\0\Flags 
 
By default, there are four zones in IE that you may customize: Internet, Local intranet, 
Trusted Sites, and Restricted Sites. Change the value above from 33 to 1. You’ll now 
have a new My Computer zone. 

122. Increase Icon Cache Size 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explore
r\ Max Cached Icons 
 
Have you ever seen your icons change from the proper icon to one for another program? 
This happens because the icon cache is full. You can change the number of icons that are 
cached in this registry key. This REG_SZ value represents the number of icons that will 
be cached. The default is 500. If you find that your icons are changing often, increase this 
number to a maximum of 2000. 

123. Disable IE’s Clicking Sound When You Click On A Link 
HKEY_CURRENT_USER\AppEvents\Schemes\Apps\Explorer\Navigating\.current 
 
Delete this key to stop IE from playing the clicking sound every time you click on a link. 

124. Change Default Wallpaper Folder 
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\WallPaperDi
r 
 
Set this to the location where your desktop wallpaper will be found on this computer.  

125. Hide Windows 2000/XP Places Bar 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\co 
mdlg32\NoPlacesBar 
 
This DWORD value should be set to 1 to hide the places bar in the Open/Save dialog 
box. 

126. Edit Windows 2000/XP Default Places Bar 
 
This comes from a Windows FAQ newsletter: 



You can modify the five default quick links in the Open and Save common dialog boxes 
by performing the following steps: 

1. Start a registry editor (e.g., regedit.exe).  
2. Navigate to the 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\
comdlg32 subkey. (If this subkey doesn’t exist, select New, Key from the Edit menu 
to create it.)  

3. From the Edit menu, select New, Key.  
4. Enter a name of 

Placesbar 
and press Enter. 

5. Navigate to the new registry subkey. You can create five entries (i.e., Place0, 
Place1, Place2, Place3, and Place4). Make each entry either a string value 
(REG_SZ) entry (for a named folder) or a DWORD value (REG_DWORD) entry 
(for a special folder, such as My Documents or My Network Places).  

6. To create a new entry, go to the Edit menu, select New, DWORD value or New, 
String Value (as appropriate), enter a name of Placen (e.g., Place0, Place4), and 
press Enter.  

7. Double-click the entry and set its REG_SZ "Value data" to a path and folder name 
or its REG_DWORD "Value data" to a numeric ID (the table below shows a partial 
list of these numeric IDs--the shlobj.h file, which is part of the platform software 
development kit (SDK), defines the full list of special numeric IDs). 

8. Close the registry editor.  
 
This change will not affect applications within the Microsoft Office suite but will affect 
applications, such as Notepad and Microsoft Paint, that use the Open and Save common 
dialog boxes. Each new entry you add will replace one of the default quick links.  
ID    Pathway 
0     Desktop  
1     Internet Explorer  
2     Start Menu\Programs  
3     My Computer\Control Panel  
4     My Computer\Printers  
5     My Documents  
6     <user name>\Favorites  
7     Start Menu\Programs\Startup  
8     <user name>\Recent  
9     <user name>\SendTo  
a     <desktop>\Recycle Bin  
b     <user name>\Start Menu  
c     Logical "My Documents" desktop icon  
d     "My Music" folder  
e     "My Videos" folder  
10    <user name>\Desktop  
11    My Computer  
12    Network Neighborhood (My Network Places)  



13    <user name>\Nethood  
14    Windows\Fonts  
16    All Users\Start Menu  
17    All Users\Start Menu\Programs  
18    All Users\Startup  
19    All Users\Desktop  
1a    <user name>\Application Data  
1b    <user name>\PrintHood  
1c    <user name>\Local Settings\Application Data  
      (nonroaming) 0x001d // nonlocalized startup  
1e    Nonlocalized common startup  
1f    Common favorites  
20    Internet cache  
21    Cookies  
22    History  
23    All Users\Application Data  
24    GetWindowsDirectory()  
25    GetSystemDirectory()  
26    C:\Program Files  
27    C:\Program Files\My Pictures  
28    USERPROFILE  
29    x86 system directory on RISC  
2a    x86 C:\Program Files on RISC  
2b    C:\Program Files\Common  
2c    x86 Program Files\Common on RISC  
2d    All Users\Templates  
2e    All Users\Documents  
2f    All Users\Start Menu\Programs\Administrative Tools  
30    <user name>\Start Menu\Programs\Administrative Tools  
31    Network and Dial-up Connections  
35    All Users\My Music  
36    All Users\My Pictures  
37    All Users\My Video  
38    Resource Directory  
39    Localized Resource Directory  
3a    All Users OEM-specific applications  
3b    USERPROFILE\Local Settings\Application Data\Microsoft\CD Burning 

127. Reinstalling Internet Explorer 6.0 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Active Setup\Installed 
Components\{89820200-ECBD-11cf-8B85-00AA005B4383}\IsInstalled. 
 
This DWORD should be set to 0 to trick Windows into thinking that IE 6 isn’t installed 



128. Reinstall Outlook Express 6.0 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Active Setup\Installed 
Components\{44BBA840-CC51-11CF-AAFA-00AA00B6015C}\IsInstalled. 
 
This DWORD should be set to 0 to trick Windows into thinking that OE 6 isn’t installed 

129. Show Which Domain a PC Is Logging In To 
HKEY_LOCAL_MACHINE\Network\Logon\DomainLogonMessage 
 
This DWORD value should be set to 1 to show which domain a computer is logging in 
to. Setting the value to 0 will disable the message. 

130. Find BIOS Information in the Registry 
HKEY_LOCAL_MACHINE\HARDWARE\DESCRIPTION\System\SystemBiosDate 
HKEY_LOCAL_MACHINE\HARDWARE\DESCRIPTION\System\SystemBiosVersio
n 
HKEY_LOCAL_MACHINE\HARDWARE\DESCRIPTION\System\VideoBiosDate 
HKEY_LOCAL_MACHINE\HARDWARE\DESCRIPTION\System\VideoBiosVersion 
 
Some information about your BIOS may be in the keys above. Do not change these 
values. They are for reference only. 

131. Disable Internet Explorer Advanced Tab 
HKEY_CURRENT_USER\Software\Policies\Microsoft\Internet Explorer\Control 
Panel\AdvancedTab 
 
Setting this to 1 will stop this tab from appearing. Change it to 0 or delete it to have the 
tab reappear. 
 

132. Display the local Administrator account on the Windows XP Welcome 
screen? 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\Winlogon\SpecialAccounts\UserList\Administrator 
 
This DWORD value should be set to 1 to show the account. Set it to 0 to hide the account 

133. Tweak the registry to disable the Shut Down button  
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\Winlogon\ShutdownWithoutLogon 
 
This value should be set to 0 to force users to logon before they shut down the computer. 



134. Disable Low Disk Warnings in Windows XP  
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Adva
nced\NoLowDiskSpaceChecks 
 
Settings this to 1 will stop the OS from checking for disk space, which will also turn of 
the Low Disk Space balloons. 

135. Disable 8.3 characters names on NTFS partitions  
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\FileSystem\NtfsDisa
ble8dot3NameCreation 
 
Set this DWORD value to 1 to stop NTFS systems from creating 8.3 character filenames. 

136. Disable multi-user editing in Microsoft Word 2002 
HKEY_CURRENT_USER\Software\Microsoft\Office\10.0\Word\Options\NoPromptTo
ForkDocuments 
 
Set this DWORD value to 1 to disable multi-user editing 

137. Disable the search assistant in Microsoft Internet Explorer (IE) 6.0 
HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\Main\Use Search Asst 
 
Settings this to NO will disable the search assistant 

138. Disable the Windows Explorer search assistant in Windows XP 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Cabi
netState\Use Search Asst 
 
Setting this String value to NO will disable the search assistant 

139. Edit registry to read all e-mail as plain text  
HKEY_CURRENT_USER\Software\Microsoft\Office\10.0\Outlook\Options\Mail\Read
AsPlain 
 
Set this DWORD value to 1 will force Outlook XP SP1 to read all email as Plain Text. 

140. Overwrite Deleted Information in Microsoft Outlook 2000/2002 
HKEY_CURRENT_USER\Software\Microsoft\Office\10.0\Outlook\PST (subkey for 
Outlook 2002) 
HKEY_CURRENT_USER\Software\Microsoft\Office\9.0\Outlook\PST (subkey for 
Outlook 2000) 
 
Set the DWORD value PSTNullFreeOnClose to 1 to instruct Outlook to remove the 
deleted data every time you close the application, then click OK 



141. Stop unwanted user access by turning off cached logins  
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows 
NT\CurrentVersion\Winlogon\CachedLogonsCount 
 
Set this to 0 to disable cached logins. This means that you must authenticate with a 
domain controller. 

142. Change location of Print Spooler 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Print\Printers\Default
SpoolDirectory 
 
Change this to any location you want 


